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 Chapter 1 

 Exploring the Interface Exploring the Interface
 Before you can start to use the new capabilities of the AutoCAD ®  2015 software, you must become®

familiar with the basics. If you’re completely new to AutoCAD, you’ll want to read this fi rst chapter 

carefully. It introduces you to many basic operations of AutoCAD, such as opening and closing fi les, 

getting a close-up look at part of a drawing, and changing a drawing. If you’re familiar with earlier

versions of AutoCAD, you should review this chapter anyway to get acquainted with the features 

you haven’t already used.

 Autodesk releases new versions of AutoCAD every year. Part of this strategy is to introduce 

improvements that focus on a particular category of features. This latest version, AutoCAD 2015, 

offers interface enhancements to make working with AutoCAD easier.

 In previous versions, AutoCAD would open directly into a new, blank drawing. AutoCAD now

opens to the Dashboard , a feature that enables you to quickly create a new drawing or open a previ-d
ously opened drawing. Recently opened drawings are shown as thumbnails in the Dashboard. 

 Other new features can be found when you start to draw. If you’ve used earlier versions of 

AutoCAD, you’ll notice a new “dark” color scheme. Line work looks smoother with a new anti-

aliasing feature. Other visual effects have been added to help you select objects and to give you

better feedback as you perform common tasks. 

 Before you begin the exercises in this chapter, make sure that you have loaded the sample fi les 

from this book’s web page at www.sybex.com/go/masteringautocad2015 . See the introduction

for details. If you have purchased the e-book version, please see the introduction for instructions

on how to download the sample fi les. 

 In this chapter, you will learn to

♦  Use the AutoCAD window

♦  Get a closer look with the Zoom command 

♦  Save a fi le as you work 

♦  Make changes and open multiple fi les

 Taking a Guided Tour
 First, you’ll get a chance to familiarize yourself with the AutoCAD screen and how you 

communicate with AutoCAD. As you do the exercises in this chapter, you’ll also get a feel for

how to work with this book. Don’t worry about understanding or remembering everything

you see in this chapter. You’ll get plenty of opportunities to probe the fi ner details of the pro-

gram as you work through the later chapters. To help you remember the material, we have 

included a brief set of questions at the end of each chapter. For now, just enjoy your fi rst excur-

sion into AutoCAD.
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 AutoCAD References in This Book

 In this chapter and throughout the rest of the book, when we say AutoCAD, we mean both 
AutoCAD and AutoCAD LT®. Some topics apply only to AutoCAD. In those situations, you’ll see 
an icon indicating that the topic applies only to AutoCAD and not to AutoCAD LT. If you’re using 
AutoCAD LT 2015, these icons can help you focus on the topics that are more relevant to your 
work by letting you skim over items that do not apply. 

 AutoCAD 2015 is designed to run on Windows 7 and Windows 8. Th is book was written using 
AutoCAD 2015 running on Windows 7 Professional. 

 Launching AutoCAD 
 If you’ve already installed AutoCAD (see Appendix B, “Installing and Setting Up AutoCAD”) and 

are ready to jump in and take a look, proceed with the following steps to launch the program: 

  1. Choose Start  ➢  All Programs  ➢ Autodesk  ➢  AutoCAD 2015 ➢  AutoCAD 2015. You can 

also double-click the AutoCAD 2015 icon on your Windows Desktop. AutoCAD LT users 

will use AutoCAD LT 2015 in place of AutoCAD 2015. 

  2. The AutoCAD Dashboard appears, offering options to open existing drawings or to cre-

ate a new drawing. You may also see the Design Feed panel, which allows you to use a 

cloud-based collaboration feature. Click the Start Drawing thumbnail in the left side of 

the view under “Get Started” (see Figure 1.1). 

  3. The AutoCAD window displays a blank default document named  Drawing1.dwg . Users

may see the Sheet Set Manager palette to the left of the AutoCAD window. AutoCAD LT

users may see the Info palette to the left of the AutoCAD window.

 FIGURE 1.1
Th e Dashboard
off ers easy access to
previous work.



TAKING A GUIDED TOUR | 5

 If you’re using the trial version, you’ll see the Product License Activation window before step 2. 

This window shows you the number of days you have left in the trial version. You can also activate 

the product here if you purchase a license. Click the Try button to continue opening the program. 

Now let’s look at the AutoCAD window in detail. Don’t worry if it seems like a lot of information.

You don’t have to memorize it, but by looking at all the parts, you’ll be aware of what is available

in a general way. 

 Th e AutoCAD Window 
 The AutoCAD program window is divided into several parts: 

♦  Application menu 

♦  Quick Access toolbar 

♦  InfoCenter 

♦  Ribbon 

♦  Drawing tabs 

♦  Drawing area

♦  UCS icon (User Coordinate System icon) 

♦  Viewport Controls 

♦  ViewCube®

♦  Navigation bar 

♦  Command window 

♦  Status bar 

 Figure 1.2 shows a typical layout of the AutoCAD program window. You can organize the 

AutoCAD window into any arrangement you want and save it as a  workspace.  You can save and 

recall a workspace at any time using the Workspace Switching tool in the Quick Access toolbar.

(You’ll learn more about this tool in the next chapter.) The default workspace in Figure 1.2 is called 

the Drafting & Annotation workspace and is one of several workspaces built into AutoCAD. 

 AutoCAD for 3D 

 For 3D modeling work, AutoCAD off ers the 3D Modeling workspace and 3D drawing templates. 
Th e combination of these two features can make AutoCAD look like a very diff erent program, 
but beneath the diff erent appearance the underlying program is the same. You’ll learn more 
about workspaces and templates later in this chapter and in Chapter 24, “Customizing Toolbars, 
Menus, Linetypes, and Hatch Patterns.” Part 4 of this book shows you the 3D features and tools 
of AutoCAD in more detail. 



6 | CHAPTER 1 EXPLORING THE INTERFACE

 FIGURE 1.2
A typical arrange-
ment of the ele-
ments in the 
AutoCAD window 

Quick Access toolbar InfoCenter

Viewport 
controls

Drawing 
area

UCS Status
bar

Navigation 
bar

ViewCube

RibbonApplication 
menu

Command 
window

 In the upper-left corner of the AutoCAD program window, the red AutoCAD icon displays the

Application menu, which offers a set of options not directly related to drawing; we’ll elaborate on

this menu in the next section. The Quick Access toolbar at the top of the drawing area (shown in

Figure 1.3) includes the basic fi le-handling functions you fi nd in nearly all Windows programs. The 

InfoCenter is the AutoCAD online help facility; you’ll learn more about it in Chapter 2, “Creating 

Your First Drawing.” The Ribbon uses icons to provide nearly all the commands you’ll need; you’ll 

learn more about it in the section “Using the Ribbon” later in this chapter.  

 FIGURE 1.3
Th e Quick Access 
toolbar, featuring
basic Windows fi le-
handling functions, 
appears above the
Ribbon. 

Ribbon tabs
Ribbon panels

Ribbon panel title bars

Quick Access toolbar InfoCenter

 The drawing area occupies most of the screen. Everything you draw appears in this area. As

you move your mouse around, crosshairs appear to move within the drawing area. This is the

drawing cursor that lets you point to locations in the drawing area. You’ll get your fi rst chance 

to work with the drawing area later, in the section “Picking Points in the Drawing Area.” 

 Just above the drawing area are the Drawing tabs that let you create new drawings or switch 

between open drawings in a way similar to popular web browsers. Notice the “x” in the current

tab that lets you close the current drawing, and the plus icon just to the right of the tab that lets

you create a new drawing or open an existing one. When you click the plus icon, the Dashboard 

appears, allowing you to start a new drawing or open an existing one. Right-click on the plus
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icon, and a context menu opens that offers you the option to open an existing drawing, to save

all of the currently open drawings, or to close all of the drawings. 

 If you hover over the Drawing tab, you’ll see preview images of the model and layouts of the 

drawing. You’ll learn more about model and layout spaces later in this chapter. 

 Within the drawing area, you see several items along the side and in the corners. The UCS

icon appears in the lower-left corner. You’ll learn more about the UCS icon in a moment. In the

upper-right corner, you see the ViewCube. The ViewCube is primarily for 3D modeling, and we

look at those techniques in Chapter 20, “Creating 3D Drawings.” You’ll also see a Navigation bar

along the right edge of the AutoCAD window. This bar offers tools you can use to get around in

your drawing. Basic tools like Zoom and Pan can be found here as well as some advanced tools 

for viewing 3D models.

 The Viewport controls in the upper-left corner of the drawing area offer menu options to 

control 3D and 2D views and visual styles and duplicate some of the functions of the ViewCube. 

You’ll explore the Viewport controls when you delve into 3D modeling in Chapter 23, “Exploring 

3D Mesh and Surface Modeling.” 

 Just below the drawing area in the lower-left corner are the Model and Layout tabs. These

tabs enable you to switch quickly between different types of views called the  model  and  layout
views. You’ll get to see fi rsthand how these work in a section called “Working with AutoCAD”

later in this chapter.

 The Command window, located just below the drawing area, gives you feedback about the

AutoCAD commands as you use them. You can move and resize this window just as you move

and resize other display components. By default, the Command window is in its undocked posi-

tion, as shown in Figure 1.4. We’ll elaborate on the Command window in the section “Working 

in the Command Window” later in this chapter.

 FIGURE 1.4
Th e Command 
window and the
status bar

Model and Layout tabs

Command window

UCS icon

Status bar

 Below the Command window is the status bar (also shown in Figure 1.4). The status bar gives 

you information at a glance about the state of the drawing. The tools in the status bar offer aids 

to the drafting process.

 Using the Application Menu
 The Application menu offers tools to help you manage your AutoCAD fi les. It is basically the 

File pull-down menu from previous versions of AutoCAD. Try it out to see how it works:

  1. Click the Application menu icon in the upper-left corner of the AutoCAD window. A list 

of options appears.

  2. Move the cursor slowly down the list of options in the left column. As you highlight the

options, additional options appear in a column to the right.

  3. Highlight the Export option to see the various formats available for export (see 

Figure 1.5). 
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 FIGURE 1.5
Th e Export option 
in the Application
menu showing
the list of export
options 

 The Application menu also gives you a convenient way to fi nd recently used fi les or to get to

a fi le you already have open. If you move your cursor away from the list of options to the left in

the Application menu, you’ll see Recent Documents in the upper-left portion of the menu. You’ll 

also see two icon tools, named Open Documents and Recent Documents (see Figure 1.6). 

 FIGURE 1.6
Th e Open Docu-
ments and Recent 
Documents tools 

Open Documents
Recent Documents

List of recent documents
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 The Open Documents option lets you quickly change from one open fi le to another when you 

are viewing your fi les full-screen. The Recent Documents option displays a list of documents on

which you’ve recently worked.

 You can use the View tool in the upper-right portion of the Application menu to select the way 

the list of fi les is displayed in a manner similar to the way you would use the Windows Explorer 

View option. You can click this icon and select Small Images to have the list display the fi les with 

thumbnail images of their content. Hover over a fi lename and you will see a tool tip that displays

a larger thumbnail of the drawing. 

 Using the Ribbon 
 The most prominent feature in the AutoCAD window, besides the drawing area, is the Ribbon 

(see Figure 1.7). This is where you’ll be selecting tools to draw, edit, or perform other functions.

The Ribbon contains a set of panels representing groups of tools and features. The name of each 

Ribbon panel is found in its title bar at the bottom of the panel. Ribbon panels are further orga-

nized by the tabs that appear above them. Each tool in the Ribbon offers a tool tip and cue card

that provides a short description to help you understand what the tool icon represents.

 FIGURE 1.7
A typical cue card 
from a Ribbon 
panel tool

Tool name

Description/tutorial

Ribbon tabs

Ribbon panels

Ribbon panel title bars

Keyboard command equivalent
Context-sensitive help

 If you see only the Ribbon tabs, click the arrowhead button in the Ribbon Control tool. If you 

don’t even see the tabs, type  Ribbon↵ . 

 Move the arrow cursor onto one of the Ribbon panel tools and leave it there for a moment; 

you’ll see a tool tip appear just below the cursor. Hold the cursor there a bit longer and the tool

tip changes to give you even more information about the tool. 

 In most cases, you’ll be able to guess what each tool does by looking at its icon. The icon with 

an arc in the Draw Ribbon panel, for instance, indicates that the tool draws arcs; the one with the 

circle shows that the tool draws circles; and so on. For further clarifi cation, the tool tip gives you 

the name of the tool.
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 Communicating with the Command Window and Dynamic Input Display 

 AutoCAD is the perfect servant: It does everything you tell it to do and no more. You communicate 
with AutoCAD by using tools and menu options, which invoke AutoCAD commands. A command
is a single-word instruction you give to AutoCAD telling it to do something, such as draw a line 
(the Line tool in the Draw Ribbon panel) or erase an object (the Erase tool in the Modify Ribbon 
panel). Whenever you invoke a command, either by typing it or by selecting an option or tool, 
AutoCAD responds by presenting messages to you in the Command window and the Dynamic 
Input display or by displaying a dialog box. Th e Dynamic Input display is the display of informa-
tion that appears at the cursor and consists of messages, dimensions, and coordinates.

 Th e messages in the Command window, or in the Dynamic Input display, often tell you what to 
do next, or they may display a list of available options. A single command often presents a series 
of messages that you answer to complete the command. Th ese messages serve as an aid to new 
users who need a little help. If you ever get lost while using a command or forget what you’re 
supposed to do, look at the Command window for clues. As you become more comfortable with 
AutoCAD, you’ll fi nd that you won’t need to refer to these messages as frequently. 

 You can also right-click to display a set of options that relate directly to your current activity. 
For example, if you right-click before picking the fi rst point for the Rectangle command, a set 
of options appears displaying the same options that are listed in the Command prompt along 
with some additional options. 

 Finally, the Dynamic Input display allows you to enter dimensional data of objects as you draw 
them. Besides echoing the command-line messages, the Dynamic Input display shows tempo-
rary dimensions, coordinates, and angles of objects you’re drawing and editing. As you enter 
coordinate or angle values through the keyboard, they appear in the Dynamic Input display. 
You can easily turn the Dynamic Input display on or off  by clicking the Dynamic Input tool in 
the status bar. When the Dynamic Input display is turned off , your keyboard input appears only 
in the Command window.

 As a new user, you’ll fi nd these tool tips helpful because they show you the name of the tool

and a brief description of how to use it. Typically, when we ask you to select a tool we’ll use the 

name shown in the tool tip to help you identify the tool. In the case of a tool with fl youts, the

tool name changes under different conditions. For those tools, we’ll use a general description

to identify the tool. You’ll learn more about fl youts a bit later in this chapter (see the section

“Understanding Flyouts”). 

 As you work through this book, we’ll ask you to select tools from the Ribbon panels. You’ll 

often be asked to switch between different tabs to select tools from other sets of panels. To make 

the process simpler to read, we’ll use a somewhat abbreviated description of a tool’s location. For 

example, for the Line tool we’ll say, “Click the Line tool in the Home tab’s Draw panel.” For the

Move tool, we’ll say, “Click the Move tool in the Home tab’s Modify panel.”

 Expanding Hidden Panels 
 In addition to the visible tools, some buttons are hidden from view. You can expand many of 

the Ribbon panels to select more of them. If you see an arrowhead to the right of a panel’s title

bar, you can click the title bar to expand the panel (see Figure 1.8). The panel expands to reveal 



TAKING A GUIDED TOUR | 11

additional tools. If you move the cursor to the drawing area, the expanded panel shrinks to

its original size. You can also click the pushpin icon in the expanded panel title bar to lock the 

panel in its open position.

 FIGURE 1.8
Th e arrowhead 
in the panel title
bar tells you that 
additional tools 
are available. 

Click the title bar to 
expand the panel.

Pushpin icon

 From now on, we’ll refer to the location of additional tools as the expanded panel. For example,

we’ll say, “Click the Ray tool in the expanded Draw panel” when we want you to select the Ray tool. 

 If you are working on a smaller screen with low resolution, some of the Ribbon panels to the

far right may look different from what you are shown in this book. On a low-resolution screen,

AutoCAD will automatically reduce the size of the panels to the right of the Ribbon so that they

show only their title (see Figure 1.9). 

 FIGURE 1.9
Th e Properties, 
Groups, Utilities, 
and View panels are
reduced to single
icons with a smaller 
AutoCAD window. 

 To see the tools, hover over the panel (see Figure 1.10). 

 Finally, the Workspace drop-down menu in the Quick Access toolbar may be hidden from 

view in a low-resolution display. If you don’t see these options in your AutoCAD window, click

the double arrowhead icon to the far right of the Quick Access toolbar to reveal it. 

 Understanding Flyouts
 The fl youts   are one more feature you’ll want to know about. Flyouts are similar to expanded 

panels because you can click an arrowhead to gain access to additional tools. Unlike a whole

panel, however, fl youts give you access to different methods for using a particular tool. For 

example, AutoCAD lets you draw circles in several ways, so it offers a fl yout for the Circle tool

in the Home tab’s Draw panel. If you click the arrowhead below the Circle icon in the Draw

panel, you’ll see additional tools for drawing circles (see Figure 1.11).
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 FIGURE 1.10
Hover over the 
panel to see 
the tools.

 FIGURE 1.11
Flyouts 

Click the flyout 
arrowhead to display 
additional tools.

 If you select a tool option from a fl yout, that option becomes the default tool for the icon you 

chose. For example, when you hover your cursor over the Circle icon in the Draw panel, the tool 

tip shows “Center, Radius” for the tool’s name. If you click the arrowhead below the Center, Radius

tool and select 2-Point, then 2-Point becomes the default tool and you’ll see “2-Point” for the name of 

the tool in the tool tip (see Figure 1.12).

 FIGURE 1.12
Th e tool with a fl y-
out will change to 
the last tool used.

The Circle tool starts out 
as Center, Radius…

Select 2-Point from the 
flyout and the default Circle 
tool becomes 2-Point.
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 General Tool Names vs. Tool Tip Names

 Because the tool tip for tools with fl youts can change, describing them by name can be a bit 
problematic. Th e name may have changed based on the last tool you used from a fl yout. For this 
reason, if a tool has a fl yout we’ll refer to it by a general name that is related to the set of tools 
contained within it rather than by the tool tip name. For example, we’ll call the circle icon tool 
the Circle tool rather than the Center, Radius tool. 

Circle tool

 Tools vs. the Keyboard

 Th roughout this book, you’ll be told to select tools from the Ribbon panels to invoke commands. 
For new and experienced users alike, the Ribbon panels off er an easy-to-remember method for 
accessing commands. If you’re an experienced AutoCAD user, you can type commands directly from 
the keyboard. Most of the keyboard commands you know and love still work as they did before.

 Many tools and commands have  aliases.  Aliases are one-, two-, or three-letter abbreviations of a
command name. As you become more profi cient with AutoCAD, you may fi nd these aliases helpful. 
As you work through this book, the shortcuts will be identifi ed for your reference.

 Finally, if you’re feeling adventurous you can create your own aliases and keyboard shortcuts for 
executing commands by adding them to the AutoCAD support fi les. Chapter 24 discusses how 
to customize menus, Ribbon panels, toolbars, and keyboard shortcuts. 

 Picking Points in the Drawing Area 
 Now that you’ve seen the general layout of AutoCAD, take a look at the coordinate readout and 

the drawing cursor to get a sense of how the parts of the AutoCAD screen work together:

  1. Move the cursor around in the drawing area. As you move it, notice how the coordi-

nate readout changes to tell you the cursor’s location. It shows the coordinates in an X,

Y, Z format. 

  2. Place the cursor in the middle of the drawing area and click the left mouse button. Move 

the cursor and a rectangle follows. This is a window selection ;  you’ll learn more about this 

window in Chapter 2. You also see a coordinate readout following the cursor and the 

message Specify opposite corner or  . This display at the cursor is called the  Dynamic 
Input display.  You’ll learn more about it a little later in this chapter (see Figure 1.13). 
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 FIGURE 1.13
Th e Dynamic Input 
display cursor

  3. Move the cursor a bit in any direction; then, click the left mouse button again. Notice that

the window selection disappears as does the Dynamic Input display.

  4. Try picking several more points in the drawing area. Notice that, as you click, you alter-

nately start and end a window selection.

 If you happen to click the right mouse button, a context menu appears. A right-click frequently

opens a menu containing options that are context sensitive.  This means the contents of the menu

depend on the location where you right-click as well as the command that is active at the time. If 

there are no appropriate options at the time of the right-click, AutoCAD treats the right-click as an

Enter ( ↵((  ) keystroke. You’ll learn more about these options as you progress through the book. For 

now, if you happen to open this menu by accident press the Esc key to close it.

 Using the UCS Icon 
 In the lower-left corner of the drawing area, you see an L-shaped line. This is the User Coordinate
System (UCS)  icon, which tells you your orientation in the drawing. This icon becomes helpful

as you start to work with complex 2D drawings and 3D models. The X and Y indicate the x- and

y-axes of your drawing. Chapter 21, “Using Advanced 3D Features,” discusses this icon in detail.

For now, you can use it as a reference to tell you the direction of the axes. 

 If You Can’t Find the UCS Icon 

 Th e UCS icon can be turned on and off , so if you’re on someone else’s system and you don’t see the 
icon or it doesn’t look as it does in this chapter, don’t panic. See Chapter 21 for more information. 

 Working in the Command Window 
 As mentioned, at the bottom of the screen, just above the status bar, is a small horizontal win-

dow called the Command window.  Here, AutoCAD displays responses to your input while you’re 

using a command. By default, it shows one line of text. This line shows the current responses to

your command input as well as command options. As you work through a command, you’ll see

more responses, with earlier responses scrolling upward in faded text. You can view text that

has scrolled out of sight by clicking the up-pointing arrowhead at the far right of the Command

window. Right now, the command line displays the words “Type a command” in a box (see 

Figure 1.4, earlier in this chapter). This tells you that AutoCAD is waiting for a command. When
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you click a point in the drawing area, you see the message  Specify opposite corner: . At the 

same time, the cursor starts to draw a window selection that disappears when you click another 

point. The same message appears in the Dynamic Input display at the cursor.

 As a new user, pay special attention to messages displayed in the Command window and the 

Dynamic Input display because this is how AutoCAD communicates with you. Besides giving you

messages, the Command window records your activity within AutoCAD. You can use the scroll

bar to the right of the Command window to review previous messages. You can also enlarge the 

window for a better view. (Chapter 2 discusses these components in more detail.)

 Now, let’s look at the AutoCAD window components in detail. 

 The Command Window and Dynamic Input Display 

 Th e Command window and the Dynamic Input display allow AutoCAD to provide text feedback 
on your actions. You can think of these features as a chat window for communicating with 
AutoCAD—as you enter commands, AutoCAD responds with messages. As you become more 
familiar with AutoCAD, you may fi nd that you don’t need to rely on the Command window and 
Dynamic Input display as much. For new and casual users, however, the Command window 
and Dynamic Input display can be helpful in understanding what steps to take as you work.

 Working with AutoCAD 
 Now that you’ve been introduced to the AutoCAD window, you’re ready to try using a few 

AutoCAD commands. First you’ll open a sample fi le and make a few modifi cations to it. In the 

process, you’ll become familiar with common methods of operation in AutoCAD. 

 Opening an Existing File
 In this exercise, you’ll get a chance to see and use a typical Select File dialog box. 

 Before you start, make sure you have installed the sample fi les for this book from the book’s 

web page. See the introduction for instructions on how to fi nd the sample fi les. 

 To start, you’ll open an existing fi le:

  1. In the Drawing tab at the top-left of the drawing area, click the Close icon to the far right 

of the tab. It looks like an X.

 A message appears, asking whether you want to save the changes you’ve made to the 

current drawing. Click No. 

  2. In the Dashboard, click the Open Files option just below the Start Drawing icon in the left 

column. The Select File dialog box opens. This is a typical Windows fi le dialog box with 

an added twist: In the large Preview box on the right, you can preview a drawing before

you open it, thereby saving time while searching for fi les. To the left is a panel known as 

the Places list, in which you can fi nd frequently used locations on your computer or the 

Internet (see Figure 1.14).
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 FIGURE 1.14
Th e Select File 
dialog box 

 If you don’t see a Preview box in the Select File dialog box, click the word Views  in the

upper-right corner and select Preview from the list that appears. 

  3. In the Select File dialog box, open the Look In drop-down list and locate the  Chapter 01
folder of the Mastering AutoCAD 2015 sample fi les. (You may need to explore the list to 

fi nd it.) 

  4. Move the arrow cursor to the clip.dwg  fi le and click it. Notice that the  clip.dwg  fi le-

name now appears in the File Name input box below the fi le list. The Preview box also 

now shows a thumbnail image of the fi le. Be aware that a thumbnail may not show for

fi les from older versions of AutoCAD. 

  5. Click the Open button at the bottom of the Select File dialog box. AutoCAD opens the 

clip.dwg  fi le, as shown in Figure 1.15. 

 FIGURE 1.15
Th e Layout1 view of 
the clip.dwg  fi le



WORKING WITH AUTOCAD | 17

 The  clip.dwg  fi le opens to display a layout  view of the drawing. A layout is a type of view in 

which you lay out different views of your drawing in preparation for printing. You can tell you are 

in a layout view by the white area over the gray background. This white area represents your draw-

ing on a printed page. This view is like a print preview.

 Also note that the AutoCAD window’s title bar displays the name of the drawing. The name

is also displayed in the Drawing tab. This offers easy identifi cation of the fi le. 

 This particular fi le contains both 2D drawings and a 3D model of a typical locking clip. The 

layout view shows top, front, and right-side views as well as an isometric view.

 Getting a Closer Look
 One of the most frequently used commands is Zoom, which gives you a closer look at part of 

your drawing. This command offers a variety of ways to control your view. In this section, you’ll 

enlarge a portion of the clip drawing to get a more detailed look. You use a zoom window  to tell

AutoCAD which area you want to enlarge.
 You’ll start by switching to a Model Space view of the drawing. The Model Space view places 

you in a workspace where you do most of your drawing creation and editing. Follow these steps: 

  1. Hover over the Clip tab at the top left of the drawing area (see the left panel in Figure 1.16). 

You’ll see two preview icons showing the Model Space on the left and the layout on the 

right. If you hover over the Model Space image, the drawing area will temporarily change

to show you the full view of the Model Space.

  2. Click the image on the left showing the Model Space (see Figure 1.16).

 FIGURE 1.16
Hover over the 
Drawing tab and
click the Model 
Space image (left)
or click the Model 
tab in the lower-left 
corner of the draw-
ing area (right). 

 Your view changes to show the full 3D model with the 2D representations of the model 

(see Figure 1.17). You can also click the Model tab below the drawing area (see the

right panel in Figure 1.16) to accomplish the same change from the layout to Model 

Space. Note that when you hover over the Model tab, you see a preview image of the

Model Space.

  3. Type PLAN↵↵ . Your display changes to a two-dimensional view looking down on the

drawing, as shown in Figure 1.18.

  4. Click the Zoom Window tool from the Zoom fl yout in the Navigation bar (see Figure 1.19).

Remember that to open the fl yout, you need to click the arrowhead next to or below the tool.

 You can also click the Window tool from the Zoom fl yout in the View tab’s Navigate 

panel (see Figure 1.20) or type the command  Z↵W↵WW  . If you don’t see the Navigate panel,

right click in the ribbon and choose Show Panels  ➢ Navigate. 
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 FIGURE 1.17
3D model with 2D 
representations of 
the model

 FIGURE 1.18
Placing the zoom 
window around
the clip 

First click here … and then click here.

 FIGURE 1.19
Choosing the Zoom
Window tool from
the Zoom fl yout in 
the Navigation bar Flyout arrowhead



WORKING WITH AUTOCAD | 19

 FIGURE 1.20
Th e Zoom fl yout
and Window tool in 
the View tab’s Navi-
gate panel 

Click the 
flyout arrowhead.

Select Window.

  5. The Dynamic Input display shows the Specify first corner:  prompt. Look at the 

image in Figure 1.18. Move the crosshair cursor to a location similar to the one shown 

in the fi gure labeled “First click here”; then, left-click. Move the cursor and the rectan-

gle appears with one corner fi xed on the point you just picked; the other corner follows 

the cursor.

  6. The Dynamic Input display now shows the  Specify opposite corner:  prompt. Position 

the other corner of the zoom window so it encloses the lower image of the clip, as shown 

in Figure 1.18, and left-click the mouse again. The clip enlarges to fi ll the screen. 

 In this exercise, you used the Window option of the Zoom command to defi ne an area to

enlarge for your close-up view. You saw how AutoCAD prompts you to indicate fi rst one corner 

of the window selection and then the other. These messages are helpful for fi rst-time users of 

AutoCAD. You’ll use the Window option frequently—not just to defi ne views but also to select

objects for editing. 

 Getting a close-up view of your drawing is crucial to working accurately, but you’ll often 

want to return to a previous view to get the overall picture. To do so, choose Zoom Previous 

from the Zoom fl yout in the Navigation bar (see Figure 1.21). You may also type  Z↵P↵PP  . 

 FIGURE 1.21
Th e Zoom Previous
option

 Do this now and the previous view appears. Click Zoom Previous again and the view show-

ing the entire clip returns to the screen. 

 You can quickly enlarge or reduce your view by using the Zoom Realtime option of the Zoom 

command. Follow these steps to change your view with Zoom Realtime: 

  1. Click the Zoom Realtime option from the Navigation bar’s Zoom fl yout. You can also 

type  Z↵↵ . 

  2. Place the Zoom Realtime cursor slightly above the center of the drawing area, and then

click and drag downward. Your view zooms out to show more of the drawing. 
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  3. While still holding the left mouse button, move the cursor upward. Your view zooms in

and enlarges. When you have a view similar to the one shown in Figure 1.22, release the

mouse button. (Don’t worry if you don’t get  exactly  the same view as the fi gure. This is

just for practice.)

 FIGURE 1.22
Th e fi nal view 
you want to 
achieve in step 3
of the exercise

  4. You’re still in Zoom Realtime mode. Click and drag the mouse again to see how you can

further adjust your view. To exit, you can select another command besides Zoom or Pan,

or press the Esc key.

  5. Press the Esc key twice to exit the Zoom Realtime command.

 If you prefer, you can use the wheel on your mouse to zoom and pan over your view. Roll 

the wheel to zoom in and out or click and drag the wheel to pan. Be aware that Zoom Realtime

offers fi ner control over the amount of magnifi cation than the mouse wheel does.

 As you can see from this exercise, you have a wide range of options for viewing your draw-

ings just by using a few tools. These tools are all you need to control the display of 2D drawings.

 Saving a File as You Work 
 It’s a good idea to save your fi le periodically as you work on it. As with any Windows program,

you can save it under its original name (click the Save tool on the Quick Access toolbar) or under

a different name (choose Save As from the Application menu or the Quick Access toolbar), 

thereby creating a new fi le. 

 By default, AutoCAD automatically saves your work at 10-minute intervals under a name that 

is a combination of the current fi lename plus a number and that ends with the .sv$  fi lename 

extension; this is known as the Automatic Save   feature. Using settings in the Options dialog box 

or system variables, you can change the name of the autosaved fi le and control the time between 

autosaves. See “The Open and Save Tab” in Appendix B for details.

 “I Can’t Find My Automatic Saves!”

 As an IT manager at ELS Architecture and Urban Planning, this author (George) is often asked, 
“Where does AutoCAD put the Automatic Save fi les?” By default, in Windows 7, the Automatic 
Save fi le is stored in  C:\Users\User Name\appdata\local\temp\ . You can fi nd the exact
location for your system by typing  Savefilepath↵  at the Command prompt. Th is fi le location 
is often set as a hidden folder, so you may need to set up Windows Explorer to display hidden 
folders before you can get to the Automatic Save fi le. You can also specify a diff erent location 
for the Automatic Save fi les. See Appendix B for information on how to locate hidden fi les and 
specify a location for your fi les. 
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 Making Changes
 You’ll frequently make changes to your drawings. One of the primary advantages of AutoCAD 

is the ease with which you can make modifi cations. The following exercise shows you a typical

sequence of operations involved in changing a drawing: 

  1. Use the Save As option in the Application menu to save the current clip.dwg  fi le under 

the name MyFirst . For convenience, you can save your fi les in the  My Documents  folder.

  2. From the Home tab’s Modify panel, click the Erase tool.

 Notice that the cursor has turned into a small square. This square is called the  pickbox .
You also see  Select objects:  in the Command window and the Dynamic Input display.

This message helps remind new users what to do. 

  3. Move the pickbox over the drawing, placing it on various parts of the clip. Don’t click

anything yet. Notice that as you hover your cursor over objects with the pickbox, they’re 

highlighted. This helps you see the objects that the pickbox is likely to select should you 

click the left mouse button.

  4. Place the pickbox on the crosshatch pattern of the clip (see Figure 1.23), and click. The

crosshatch becomes highlighted. The pickbox and the  Select objects:  prompt remain, 

indicating that you can continue to select objects.

 FIGURE 1.23
Erasing a portion of 
the clip 

Click here.

  5. Press ↵ . The crosshatch disappears. You’ve just erased a part of the drawing. 

 In this exercise, fi rst you issued the Erase command and then you selected an object by using

a pickbox to click it. The pickbox tells you that you must select items on the screen, and it shows

you what you’re about to select by highlighting objects as you hover the cursor over them. Once

you’ve clicked an object or a set of objects, press  ↵  to move on to the next step. This sequence of 

steps is common to many of the commands you’ll work with in AutoCAD. 

 You can also click an object or a set of objects and then press the Delete key.

 Working with Multiple Files 
 You can have multiple documents open at the same time in AutoCAD. This feature can be espe-

cially helpful if you want to exchange parts of drawings between fi les or if you want another fi le 

open for reference. Try the following exercise to see how multiple documents work in AutoCAD:

  1. Click the plus icon to the right of the MyFirst tab at the top of the drawing area. 

  2. In the Dashboard, locate the Templates option at the bottom of the Start Drawing icon

and click it (Figure 1.24).
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 FIGURE 1.24
Click the Templates
option below the
Start Drawing icon. 

  3. Select acad.dwt from the drop-down list.

  4. Go to the Ribbon and in the View tab’s User Interface panel, click Tile Vertically to get a

view of both drawing fi les. 

 When you create a new fi le in AutoCAD, you’re actually opening a copy of a template fi le, as e
you saw in step 1. A template fi le is a blank fi le that is set up for specifi c drawing types. The

acad.dwt  fi le is a generic template set up for Imperial measurements. Another template fi le, 

called  acadiso.dwt , is a generic template useful for metric measurements. Other templates 

are set up for specifi c drawing-sheet sizes and measurement systems. You’ll learn more about 

templates in Chapter 6, “Editing and Reusing Data to Work Effi ciently.” 

 Next, let’s try drawing a rectangle to see how AutoCAD behaves while drawing objects:

  1. Click the Rectangle tool in the Home tab’s Draw panel, as shown in Figure 1.25.

 FIGURE 1.25
Click the Rectangle 
tool in the Draw 
panel. 

 Notice that the Command window now shows the following prompt:

 Specify first corner point or 
 [Chamfer/Elevation/Fillet/Thickness/Width]: 

 AutoCAD is asking you to select the fi rst corner for the rectangle, and in brackets, it’s 

offering a few options you can take advantage of at this point in the command. Don’t

worry about those options right now. You’ll have an opportunity to learn about com-

mand options in Chapter 2. You also see the same prompt, minus the bracketed options, 

in the Dynamic Input display at the cursor. You can view the command options at the 

cursor by pressing the down arrow key on your keyboard. 

  2. Click a point roughly in the lower-left corner of the drawing area, as shown in Figure 1.26. 

Now as you move your mouse, a rectangle follows the cursor, with one corner fi xed at the 

position you just selected. You also see the following prompt in the Command window,

with a similar prompt in the Dynamic Input display:

 Specify other corner point or [Area/Dimensions/Rotation]: 
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 FIGURE 1.26
Selecting the fi rst 
point of a rectangle 

Click here to start the rectangle.

  3. Click another point anywhere in the upper-right region of the drawing area (see Figure 1.27). 

A rectangle appears. You’ll learn more about the different cursor shapes and what they

mean in Chapter 2.

 FIGURE 1.27
After you’ve 
selected the fi rst
point of the rect-
angle, you’ll see a
rectangle follow 
the motion of 
your mouse. 

  4. Let’s try copying objects between these two fi les. Click in the window with the clip 

drawing to make it active. 

  5. Click Zoom All from the Zoom fl yout of the Navigation bar to get an overall view of the 

drawing (see Figure 1.28). You can also type Z↵A↵↵ ↵ . 

 FIGURE 1.28
Th e Zoom All
option gives you 
an overall view of 
your drawing.
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  6. Click the 2D version of the clip at the bottom of the drawing to select it. A dot appears at

the center of the clip and a rectangle encloses it. The dot is called a  grip  ; you’ll learn more 

about grips in the next chapter (see Figure 1.29).

 FIGURE 1.29
Grip shown in the 
2D drawing

Select this part 
of the drawing.

  7. Right-click and select Clipboard and then Copy. You can also press Ctrl+C to invoke the

Windows Copy To Clipboard shortcut.

  8. Click inside the other drawing window to make it active. 

  9. Right-click and select Clipboard and then Paste. You can also press Ctrl+V to invoke the

Windows Paste From Clipboard shortcut. The Specify Insertion Point prompt appears. 

  10. Click inside the rectangle. The clip appears at the cursor in the new drawing.

  11. This ends the exercises for this chapter. Save your myfirst.dwg  fi le for future reference.

 Lose the Navigation Bar?

 If for some reason the Navigation bar is not visible, you can use the User Interface tool found in 
the User Interface panel of the View tab on the Ribbon to open it again. Click the User Interface 
tool and select Navigation Bar from the menu.

 Note that you’ve had two fi les open at once. You can have as many fi les open as you want

as long as your computer has adequate memory to accommodate them. You can control the

individual document windows as you would any window, using the window control buttons 

in the upper-right corner of the drawing area. 
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 Adding a Predrawn Symbol with the Tool Palettes 
 In the preceding exercise, you saw how you can easily copy an object from one fi le to another by 

using the standard Windows Cut and Paste feature. AutoCAD offers several tool palettes that

enable you to click and drag predrawn objects into your drawing.

 You can open the tool palettes by clicking the Tool Palettes tool in the Interface tab’s Palettes 

panel, as shown in Figure 1.30.

 FIGURE 1.30
Open the Tool 
Palettes tool from 
the View tab.

View tab
Tool Palettes tool in the Palettes panel

 Once the tool palettes are open, you can select a tab containing the predrawn objects you 

want to use and then click the specifi c object you want to add. The object appears at the cursor, 

ready for you to select a location (see Figure 1.31).

 In addition to predrawn objects, the tool palettes offer a way to add hatch patterns and other 

components quickly to your drawing. They’re great tools to help you manage your library of 

custom, predrawn symbols. Chapter 25, “Managing and Sharing Your Drawings,” shows you

how to use and customize the tool palettes.

 FIGURE 1.31
Th e tool palettes
off er predrawn
symbols that you
can easily place in 
your drawings.

The symbol appears at the cursor ready to be placed in the drawing.

Select a tab containing predrawn 
symbols you want to use. Click on a symbol.
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 Th e Bottom Line
 Use the AutoCAD window.  AutoCAD is a typical Windows graphics program that

makes use of menus, toolbars, Ribbon panels, and palettes. If you’ve used other graphics 

programs, you’ll see at least a few familiar tools. 

 Master It  Name the components of the AutoCAD window you can use to select a 

function.

 Get a closer look with the Zoom command.  One of the fi rst things you’ll want to learn is 

how to manipulate your views. The Zoom command is a common tool in graphics programs.

 Master It  Name at least two ways of zooming into a view. 

 Save a fi le as you work.  Nothing is more frustrating than having a power failure that causes 

you to lose hours of work. It’s a good idea to save your work frequently. AutoCAD offers an 

Automatic Save feature that can be a lifesaver if you happen to forget to save your fi les. 

 Master It  How often does the AutoCAD Automatic Save feature save your drawing? 

 Make changes and open multiple fi les.  As with other Windows programs, you can have 

multiple fi les open and exchange data between them.

 Master It  With two drawings open, how can you copy parts of one drawing into the other? 


